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Введение

Задачи этого документа

Руководство «Получение результатов с помощью RSLinx Classic™»  предоставляет 
вам информацию о том, как устанавливать и использовать программное 
обеспечение RSLinx Classic. В этом Руководстве объясняется, как получить доступ к 
интерактивной справочной системе и перемещаться по ней, а также как эффективно 
использовать программное обеспечение RSLinx Classic.

Целевая аудитория

При составлении данного Руководства по эксплуатации, мы исходили из 
предположения, что вы знакомы с:

■ IBM-совместими персональными компьютерами
■ Операционными системами Microsoft® Windows®
■ Инструментами OLE для протокола Process Control Communication® (OPC) 
■ Передача сообщений посредством динамического обмена данными (DDE) компании 

Microsoft
■ Контроллерами с программируемой логикой Allen-Bradley (PLC™)
■ Средствами программирования Rockwell Software’s PLC 

Какое место занимает данное руководство среди другой документации 
на данный продукт компании Rockwell Software?

Данное руководство может рассматриваться как основной документ, с которого 
следует начать ознакомление с пакетом документации на программное обеспечение 
Rockwell для изучения возможностей данной программы. Данный пакет документов 
содержит ясную и доступную информации по программе, и поставляется с 
программным продуктом. Данный пакет документов поставляется вместе с 
программным продуктом, и предназначен для того,чтобы освободить пользователя 
от утомительного перелистывания, и свести информационную нагрузку к 
минимуму.
Другие части документации включены в электронные справочные материалы, и 
ссылки на справочные онлайн ресурсы. 
1
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Интерактивная справочная система

Интерактивная справка включает всю обзорную информацию, информацию по 
процедурам, экранам и справочную информацию по продукту. Справка состоит из 
следующих основных компонентов: обзорных тематических разделов, разделов по 
быстрому началу работы, пошаговых процедур и  описаний элементов экрана 
(например, текстовых полей, раскрывающихся списков, и кнопок параметров). Все 
элементы справочной системы контекстно-зависимы от приложения и 
обеспечивают пользователю немедленный доступ к прикладным задачам и 
описаниям элементов экрана. Для получения более детального описания 
интерактивной справочной системы просмотрите в этом руководстве раздел «Поиск 
необходимой информации».
Примечание: Это руководство по использованию содержится на вашем компакт-диске 
RSLinx Classic в портативном формате документов (PDF, так же как любые другие 
справочные материалы, относящиеся к данному ПО. Эти файлы нужно просматривать, 
используя программное обеспечение Adobe Acrobat Reader, которое вы можете 
загрузить бесплатно от сайта компании Adobe (www.adobe.com).

Условные обозначения в документе

Условные обозначения, используемые в этом документе для пользовательского 
интерфейса, используются в соответствии с рекомендациями компании Microsoft. 
Если вы не знакомы с интерфейсом пользователя Microsoft Windows, мы 
рекомендуем ознакомиться с документацией, которая прилагается к вашей 
операционной системе, прежде чем использовать это программное обеспечение.

Обратная связь

Найденные ошибки и/или предложения о включении дополнительной информации 
в последующие издания данного документа просим внести в специальную форму 
для откликов пользователей, прилагаемую к программному продукту. Вы также 
можете направлять сообщения с любыми комментариями по продуктам и услугам 
компании Rockwell на электронный адрес info@software.rockwell.com.
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 Знакомство с RSLinx Classic
Данная глава включает следующую информацию:
■ Что такое RSLinx Classic?
■ Различия между отдельными типами RSLinx Classic.
■ Быстрый старт
■ Обзор RSLinx Classic

Что такое RSLinx Classic?

RSLinx Classic для сетей и устройств Rockwell Automation – это комплексное 
программное обеспечение по обеспечению связи на производстве, предназначенное 
для использования со следующими операционными системами:
■ Microsoft Windows XP, XP SP1, или XP SP2
■ Сервер Microsoft Windows 2003 SP1 или R2
■ Microsoft Windows 2000 или SP4

Это решение обеспечивает доступ программируемого контроллера Allen-Bradley  к 
широкому набору приложений Rockwell Software и Allen-Bradley. Эти приложения 
различаются в широком диапазоне от приложений по программированию устройств 
и настройке конфигурации, таких как RSLogix и RSNetWorx, до приложений HMI 
(человеко-машинного интерфейса), такие как RSView32, и собственные приложения 
пользователя, предназначенные для получения и накопления данных, и 
использующие приложения Microsoft Office, Интернет-страницы, или Visual Basic 
®. RSLinx Classic также включает расширенные методы оптимизации данных и 
содержит набор диагностики. Это интерфейс прикладного программирования (API), 
который поддерживает специальные приложения, разработанные с помощью пакета 
приложений RSLinx Classic SDK. RSLinx Classic является OPC совместимого 
сервера доступа к данным и сервером динамического обмена данными (DDE).

Различия между отдельными типами приложений RSLinx Classic

Продукт RSLinx Classic имеется в пяти версиях, что позволяет удовлетворить 
требования многих различных приложений по стоимости и функциональным 
возможностям. В зависимости от используемой вами версии некоторые 
функциональные возможности могут быть доступны или нет. Чтобы получить 
дополнительные сведения по использованию функциональных возможностей 
конкретной версии,  обратитесь к следующим разделам.
Используемая вами версия RSLinx Classic указывается в строке заголовка в 
верхней части главного окна. Если версия RSLinx Classic была установлена без 
надлежащих файлов активации, то статус установленной программы возвращается к 
версии RSLinx Classic Lite.
3
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RSLinx Classic Lite

RSLinx Classic Lite обеспечивает минимальный набор функциональных возможностей, 
требуемый для поддержки RSLogix и RSNetWorx. Данная версия не имеется в 
продаже, но поставляется в комплекте с продуктами, требующими только прямого 
доступа к сетевым драйверам RSLinx Classic. Эта версия не поддерживает OPC, DDE, 
или вышедший интерфейс прикладного программирования RSLinx Classic на языке С.
RSLinx Classic Lite используется для следующего:
■ Программирование многозвенной логики с использованием программ RSLogix.
■ Конфигурация сети и устройств, а так же средств диагностики, использующих 

RSNetWorx.
■ Конфигурирование 1756-ENET, 1756-DHRIO, и 1757-SRM модулей.
■ Обновление встроенного программного обеспечения с использованием ControlFlash.
■ Навигация в сетях и получение информации об устройствах, например проверка 

встроенного программного обеспечения.

RSLinx Classic Single Node

RSLinx Classic Single Node включает все необходимые функциональные 
возможности, чтобы обеспечить сервисы связи для всех программных продуктов 
Rockwell.  Поддерживаются интерфейсы OPC и DDE, но только на одно устройство. 
Этот модуль не поддерживает приложения, разработанные для интерфейса 
прикладного программирования RSLinx Classic (API) на языке С, или прямые 
драйверы в приложениях HMI. Для открытия этих типов приложений требуется 
RSLinx Classic OEM или выше.
RSLinx Classic Single Node используется для следующего:
■ Получение и накопление данных с использованием OPC или динамический обмен 

данными  только на одно устройство. Этот набор приложений включает клиенты 
типа RSView32, Microsoft Office, Visual Basic, и редакторы Интернет-страниц.

■ Программирование многозвенной логики с использованием программ RSLogix.
■ Конфигурация сети и устройств, а так же средства диагностики, использующие 

RSNetWorx.
■ Конфигурирование 1756-ENET, 1756-DHRIO, и 1757-SRM модулей.
■ Обновление встроенного программного обеспечения с использованием ControlFlash.
■ Навигация в сетях и получение информации об устройствах, например проверка 

встроенного программного обеспечения.

RSLinx Classic OEM

RSLinx Classic OEM включает все необходимые функциональные возможности, 
чтобы обеспечить услуги связи для всех программных продуктов Rockwell. OPC и 
DDE клиенты поддерживаются для любого количества устройств. Этот модуль 
поддерживает приложения, разработанные для интерфейса прикладного 
программирования RSLinx Classic (API) на языке С.
RSLinx OEM Версии 2.2 и предыдущие версии поддерживали только формат 
AdvanceDDE. RSLinx Версия 2.3 и последующие версии поддерживают все типы 
динамического обмена данными кроме FastDDE.
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RSLinx Classic OEM используется для следующего:
■ Получение и накопление данных с использованием OPC или DDE на любое 

количество устройств. Этот набор приложений включает клиенты типа RSView32, 
Microsoft Office, Visual Basic, и редакторы Интернет-страниц.

■ Программирование многозвенной логики с использованием программ RSLogix.
■ Конфигурация сети и устройств, а так же средства диагностики, использующие 

RSNetWorx.
■ Конфигурирование 1756-ENET, 1756-DHRIO, и 1757-SRM модулей.
■ Обновление встроенного программного обеспечения с использованием ControlFlash.
■ Навигация в сетях и получение информации об устройствах, например проверка 

встроенного программного обеспечения.

RSLinx Classic Gateway

Шлюз RSLinx Classic Gateway распространяет связи на основе RSLinx по всему 
предприятию, подключая клиентов к сетям через протоколы TCP/IP. 
Программирование и программы настройки конфигурации типа RSLogix и 
RSNetWorx используют локальные версии RSLinx Classic Lite или лучше, с 
удаленными устройствами через межсетевой драйвер Linx Gateway, который 
настроен таким образом. Чтобы обеспечивать связь с шлюзом RSLinx Classic 
Gateway. Удаленные клиенты HMI и приложения VB/VBA, включая Microsoft 
Office, могут использовать удаленный клиент OPC для связи с шлюзом RSLinx 
Classic Gateway для сбора данных. Это позволяет пользователю быстро искать и 
находить многочисленные распределенные компьютеры, выполняющие сбор 
данных, при этом не устанавливая RSLinx Classic на каждой машине.
В дополнение к функциональным возможностям, предоставленным в версии RSLinx 
Classic Professional, шлюз RSLinx Classic Gateway предлагает клиенты для 
удаленного обеспечения связи:
■ Множественные клиенты RSView32, обращающиеся к данным через один шлюз 

RSLinx Classic Gateway (отдаленный OPC).
■ Удаленный компьютер, выполняющий операции с помощью RSLogix 

подключающийся к корпоративной сети по модему для внесения изменений в 
программы в режиме реального времени.

■ Удаленные приложения Microsoft Office, в которых содержаться данные 
прикладного приложения, такие как Excel.

■ Интернет-страница, на которой отображаются производственные данные, когда 
сервер сети и RSLinx Classic находятся на разных компьютерах.

RSLinx Classic для FactoryTalk View

Если RSLinx Classic Lite (без активации) установлен на компьютере, на котором 
установлен FactoryTalk View для Windows SE/ME, то нужно использовать лицензию 
FactoryTalk View, чтобы начать работать с приложением RSLinx Classic для 
FactoryTalk View. 
Однако следует иметь в виду, что RSLinx Classic для FactoryTalk View:
5
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■ в дополнение к поддержке FactoryTalk View для Windows SE/ME, поддерживает 
OPC клиенты, а также поддерживает RSLadder 5/500 и Data Monitor.

■ Не поддерживает такие приложения как RSView32, FactoryTalk Transaction Manager, 
RSTrend, Win View, RSLogix 5/500/5000 и сторонние OPC клиенты.

Быстрый старт
В данном разделе очерчены основные задачи, которые вам потребуется выполнить 
для использования программного обеспечения RSLinx Classic. Информация о быстром 
начале работы, включенная в данное руководство, носит общий, концептуальный 
характер. Когда вы будете готовы к использованию программного обеспечения RSLinx, 
следуйте процедурам, подробно описанным в разделе Quick Start (Быстрое начало 
работы), содержащемся в интерактивной справочной системе продукта RSLinx Classic 
Для доступа к интерактивному разделу Quick Start выберите в меню программы RSLinx 
Classic Help > Quick Start. Для получения информации о конкретных элементах 
управления окон приложения и диалоговых окон RSLinx Classic, щелкните правой 
кнопкой мыши на любом элементе управления.

Шаг 1 - Конфигурирование драйвера.

Драйвер - это интерфейс программного продукта с аппаратным устройством, который 
будет использоваться для обмена информацей между RSLinx Classic и вашим 
процессором. Чтобы настроить конфигурацию драйвера в RSLinx Classic, выберите в меню 
программы пункты Communications > Configure Drivers (Связи> Конфигурирование 
драйверов) . На экране появится диалоговое окно Configure Drivers, которое используется для 
добавления, редактирования, или удаления драйверов. Выберите драйвер, чтобы настроить 
его конфигурацию из списка Available Driver Types (доступные типы драйверов), затем 
щелкните кнопку Add New (добавить новый), и заполните поля нужной информацией, 
которая запрашивается в диалоговом окне настройки конфигурации драйвера, которое 
отображается на экране. Диалоговое окно настройки конфигурации может изменяться в 
зависимости от того, какой драйвер был выбран пользователем. 
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Шаг 2 - Конфигурирование раздела.

В RSLinx Classic проект является контейнером для хранения одного или нескольких 
разделов, и каждый раздел представляет собой конкретный путь к процессору. 
Группируя разделы в рамках одного проекта, пользователь может создавать несколько 
разделов, доступных одновременно. Проекты могут быть созданы и отредактированы в 
RSLinx Classic с помощью окна Open Project (Открыть проект), а разделы могут быть 
созданы и отредактированы посредством окна DDE/OPC Topic Configuration 
(Конфигурирование раздела DDE/OPC). Если пользователь попытается создать раздел, 
не создавая проект, то будет создан проект, заданный по умолчанию.

Если пользователь выбрал пункт меню Configure New DDE/OPC Topic (настроить новый 
раздел DDE/OPC), щелкнув правой кнопкой мыши на станции в RSWho, то появится 
поле Topic Name (название раздела) с заполненными полями. Работа программы RSLinx 
Classic начинается с установления названия программы, которая выполняется в 
процессоре. Если соответствующий раздел уже существует, то в конце будет 
добавляться номер. Это будет продолжаться до тех пор, пока не встретится раздел, 
которого еще не существует. Если есть какие-либо пустые слоты, то программа 
конвертирует их в пустые поля с названием _’s. Пользователь может изменить название 
выбранного раздела в RSLinx Classic.

Из вкладки Data Source (источник данных), выберите устройство, с которым нужно 
установить связь. Чтобы добавить новый раздел к проекту, который уже имеет по 
крайней мере один раздел с конфигурацией, нажмите на пункт меню New. Чтобы 
редактировать существующий раздел, выберите нужный раздел из списка. Используйте 
вкладку Data Collection (Сбор данных) для включения более подробной информации о 
конкретных разделах.

е 
оторый 
авлен в 
вом 
E/OPC 
nfigura-

рите 
нель 
писок, 
айти 
ю 
 нужную 
7



ПОЛУЧЕНИЕ РЕЗУЛЬТАТОВ ПРИ ПОМОЩИ RSLINX CLASSIC

●
●
●
●
●

8

Выбер
раздел
был до
диалог
окне D
OPC T
Config
просмо
через п
обзора
чтобы
адресн
строк
для ваш
запрос
Шаг 3 – Копирование ссылки в буфер обмена

Продукт RSLinx Classic предоставляет механизм для быстрого создания «горячей» 
ссылки между RSLinx и совместимой программой путем помещения информации, 
необходимой для создания ссылки, в буфер обмена Windows.  Некоторые пакеты 
поддерживают возможность вставлять ссылки из буфера обмена. Функции Copy to 
Clipboard (копировать в буфер) может использоваться только в этих приложениях.

Функция Copy to Clipboard только устанавливает «горячие» ссылки между RSLinx 
Classic через DDE сервер и приложением DDE клиента в среде Windows. Вкладки 
Data Table Address (Адрес таблицы данных), Block Size (Размер блока), Columns 
per Row (Столбцов на строку), и выбранный раздел сохраняют свои значения 
такими, какими они были при последнем использовании этой функции. Изменение 
этих значений не будет иметь никакого влияния на последнюю установленную 
ссылку. Чтобы использовать функции Copy to Clipboard, нужно выбрать проект 
RSLinx Classic. При этом выбранный проект должен содержать разделы.
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Шаг 4 – Вставка ссылки из буфера обмена.

Большинство приложений Windows поддерживает операцию Paste Link (вставить 
ссылку), которая обычно выполняется из меню Edit (Редактировать).
Зайдите в вашу прикладную программу, которая поддерживает функцию Paste Link 
(вставить ссылку). Например, в программе Microsoft Excel щелкните по открытой 
ячейке в электронной таблице, где вы хотели бы разместить данные, затем выберите 
в меню Edit>Paste Special (специальная вставка), затем выберите команду Paste 
Link, и нажмите OK. При этом горячая ссылка будет вставлена в электронную 
таблицу в ту локацию, которая была выбрана пользователем, и таблица будет 
обновлена. Обратите внимание, что, если вы выберете команду Paste (вставка), то 
вместо ссылки будет скопирована строка элемента меню 
9
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Обзор RSLinx Classic

При запуске RSLinx Classic, на экране появится окно приложения Rockwell RSLinx 
Classic. Окно приложения содержит поле заголовка, строку меню, панель 
инструментов, и рабочее пространство, где открываются дочерние окна (RSWho, 
диагностика, и т.д.), и строку состояния.

Строка заголовка

В строке заголовка отображается значок RSLinx Classic, название программного 
продукта, например Rockwell Software RSLinx Classic Gateway, количество копий 
RSWho (RSWho - 1 открывается по умолчанию, когда вы открываете программу 
RSLinx Classic), а также кнопки функций Minimize (свернуть), Maximize 
(развернуть), и Close (закрыть).

Для доступа к меню Control Menu (меню управления), нажмите значок RSLinx 
Classic в строке заголовка. В меню Control отображаются следующие элементы:

Пункт меню Описание

Restore 
(Восстановить)

 Восстанавливает окно к его прежнему размеру после того, как его 
размер был увеличен с помощью команды Maximize, или уменьшено с 
помощью команды Minimize.

Move 
(Переместить)

 Позволяет вам перемещать окно в другое место на рабочем столе, 
используя клавиши курсора на клавиатуре

Size (Изменить 
Размер)

  Позволяет изменять размер окна на рабочем столе, используя клавиши 
стрелок на клавиатуре

Minimize 
(Свернуть)

 Сворачивает окно в значок, который расположен на панели задач. 
Выполняет ту же самую функцию, как и кнопка свертывания окна в 
строке заголовка.

Maximize 
(Развернуть)

   Увеличивает окно, чтобы занять полный экран. Эта команда выполняет 
ту же самую функцию, как и кнопка развертывания окна в строке 
заголовка.

Close  (Закрыть)    Обеспечивает выход из приложения RSLinx Classic. Выполняет ту же 
самую функцию, как и кнопка закрытия окна в строке заголовка.
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Строка меню

Строка меню RSLinx Classic содержит следующие элементы:

Каждое меню содержит следующие варианты выбора команд, чтобы выполнить 
следующие задачи:

Строка меню. Описание

File (Файл) Позволяет создавать и открывать проекты RSLinx Classic.

Edit (Правка) Копирует ссылки DDE и OPC в буфер обмена.

View (Вид) Обеспечивает установку и изменение интерфейсных дисплеев RSLinx 
Classic. Чтобы выполнить эту команду, откройте пункт меню Event 
Viewer (просмотр событий), и выберите нужный режим представления 
RSWho.

Communications 
(Связь) 

Этот пункт меню позволяет выполнить настройку конфигурации для 
драйверов, разделов, и других параметров программы RSLinx Classic, и 
обзор драйверов, вызов средств динамического обмена данными, и 
других приложений клиента.

Station (Станции) Выполняет действия над диагностическими счетчиками, просмотр 
монитора данных с помощью модуля Data Monitor.

DDE/OPC Позволяет выполнять настройку конфигурации разделов DDE/OPC, и 
просматривать журнал событий и результатов диагностики.

Security 
(Безопасность)

Позволяет настраивать режимы защиты данных пользователя и права 
доступа.

Window (Окно) Позволяет упорядочивать окна в программе RSLinx Classic.

Help (Справка) Варианты настройки режимов представления разделов справки для 
программы RSLinx Classic и других программ и сервисов Rockwell.
11
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Панель инструментов

Панель инструментов RSLinx Classic содержит семь кнопок быстрого вызова часто 
используемых функций RSLinx Classic. Каждая кнопка - это графическое 
представление команды элемента меню. В панели инструментов программы 
RSLinx Classic отображаются следующие элементы:

Значок Выбранный пункт меню Описание

File > Open Project (Файл> 
Открыть проект)

Отображает  определенные проекты в настоящее 
время, и позволяет открывать проект через 
интерфейс DDE/OPC. 

Communications >RSWho 
(Связь>RSWho)

Открывает дополнительную копию RSWho (одна 
копия открывается по умолчанию каждый раз, когда 
открывается программа RSLinx Classic).

Communications > 
Configure Drivers (Связь> 
Конфигурирование 
драйверов) 

Отображает текущую конфигурацию драйверов 
программного обеспечения RSLinx Classic, и 
позволяет добавлять дополнительные драйверы для 
использования вместе с аппаратными устройствами 
пользователя.

Communications > Driver 
Diagnostics (Связь> 
Диагностика драйверов)

Отображает список текущей конфигурации 
драйверов, и обеспечивает возможности для 
просмотра диагностической информации для 
каждого драйвера.

Edit > Copy DDE/OPC Link 
(Правка> Копировать 
ссылку DDE/OPC)

Обеспечивает возможность создать ссылку через 
интерфейс DDE/OPC между программой RSLinx 
Classic и приложением клиента типа Microsoft Excel.

 DDE/OPC > Topic 
Configuration (DDE/OPC 
>Конфигурирование 
раздела)

Позволяет создавать и изменять раздел DDE/OPC, 
который также является конкретным путем к 
процессору.

Help > What’s This? 
(Справка> Что это?)

Изменяет курсор на стрелку и знак вопроса, чтобы 
указать, что указатель находится в режиме справки. 
Щелкните кнопкой мыши на любом элементе экрана, 
чтобы отобразить текст справки по данному 
элементу, и выйти из режима справки. 
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Рабочая область приложения

В рабочей области приложения выводятся открытые дочерние окна, такие как 
диалоговые окна RSWHO и RSLinx Classic.

Строка состояния

Строка состояния в нижней части экрана RSLinx Classic обеспечивает информацию 
о текущем состоянии вашей системы.

Левая область строки состояния используется для передачи сообщений 
пользователю. Например, когда вы продвигаетесь по элементам меню, краткое 
описание функции данного элемента меню появляется в этой части строки 
состояния
В правой стороне строки состояния выводятся:
■ CAP – индикатор, показывающий, что на вашей клавиатуре включена клавиша Caps 

Lock, которая переключает все буквы на заглавные.
■ NUM – индикатор, который подсвечивается, если на вашей клавиатуре включена 

клавиша Num Lock, которая включает набор цифр на дополнительной клавиатуре.
■ SCRL – индикатор, показывающий, что на вашей клавиатуре включена клавиша 

Scroll Lock которая блокирует прокрутку экрана.
■ Текущая дата на системных часах/календаре вашего компьютера.
■ Текущее время на системных часах/календаре вашего компьютера.
13
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2
 Установка и запуск RSLinx Classic
Эта глава объясняет, как установить и запустить программное обеспечение RSLinx 
Classic. Эта глава включает следующую информацию:

■ Системные требования
■ Процедура инсталляции 
■ Обновление существующей инсталляции
■ Стартовая процедура
■ Устранение неисправностей при инсталляции
После установки программного обеспечения рекомендуется прочитать примечания, 
которые находятся интерактивной справке. Примечания могут содержать более 
свежую информацию, чем та информация, которая была внесена в этот документ в 
то время, когда он был издан. Чтобы просмотреть примечания, запустите программу 
RSLinx Classic, затем выберите в главном меню пункт Help> Release Notes 
(Примечания по данной версии).
Примечание: Если вы работаете в операционной системе Windows NT и выполняете 
задачи, о которых вы будете читать в этой главе, то нужно иметь права системного 
администратора Windows NT. При этом ваша учетная запись пользователя должна 
быть членом локальной группы пользователей «администратор». Для получения 
дополнительной информации обратитесь к вашему системному администратору.

Перед началом работы

Программное обеспечение Rockwell использует программный ключ, чтобы 
осуществить защиту от копирования для программных продуктов в системе 
Windows. Каждый программный продукт имеет уникальный ключ. Вы можете 
установить программное обеспечение на любом количестве компьютеров, но 
лицензия не позволяет использовать данное программное обеспечение 
одновременно более, чем на одном компьютере. После завершения установки 
программного обеспечения RSLinx Classic, программа Setup (Установка) выведет 
запрос по активации вашего программного обеспечения. Для получения 
дополнительной информации о перемещении программных ключей, защиты от 
копирования, и активации программного обеспечения, обратитесь к Приложению A 
в данном руководстве.

Системные требования

Чтобы эффективно использовать RSLinx Classic, ваш персональный компьютер 
должен соответствовать следующим минимальным аппаратным и программным 
требованиям:

Аппаратные требования

Чтобы установить ПО RSLinx Classic, необходимо, чтобы на вашем компьютере 
было установлено следующее оборудование и устройства:

■ Процессор Pentium 100MHz с не менее чем 32 мегабайтами (Мбайт) оперативной 
памяти. Эта версия RSLinx Classic не будет выполняться на процессорах Alpha, 
15
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MIPS, или Power. Версии Windows NT для различных процессоров часто бывают 
несовместимы на уровне двоичных кодов.

■ не менее 350 Мбайт доступного места на жестком диске; для определенных 
функциональных возможностей приложений может понадобиться немного больше 
пространства на жестком диске.

■ дисплей SVGA с 16 цветами, поддерживающий режим 800*600 пикселей, или 
большее разрешение.

■ мышь или другое устройство-указатель совместимое с Windows.
■ карта для сети Ethernet и/или устройство связи Allen-Bradley, и сетевой кабель.

Программные требования

Чтобы запустить программу RSLinx Classic, нужен браузер Microsoft Internet 
Explorer версии 6 или выше и одна из следующих операционных систем:

■ системы Microsoft Windows XP, XP SP1, и XP SP2.
■ система Microsoft Windows 2003 SP1 или R2.
■ система Microsoft Windows 2000 или SP4

Установка и запуск ПО RSLinx Classic

Вы можете установить одну или более программ Rockwell один персональный 
компьютер. 
Примечание: При установке программного обеспечения RSLinx Classic вы будете иметь 
возможность определить рабочую папку. По умолчанию, программа предлагает 
основной каталог - x:\Program <file://x:/Program> Files\Rockwell Software\RSLinx, где x – 
обозначение диска, на который будет устанавливаться RSLinx Classic. Мы 
рекомендуем, чтобы вы использовали основную папку, если это возможно.
В процедурах, о которых рассказывается в этом документе, предполагается, что вы 
использовали имя папки заданное по умолчанию. Если вы не использовали заданное по 
умолчанию имя папки, то нужно заменить имя папки, предложенное программой по 
умолчанию, на текущее имя рабочей папки, которое вы определили при настройке 
программы.
Чтобы установить ПО RSLinx Classic, нужно выполнить следующие действия:
1. Запустите свою операционную систему Windows (если она не запускается 

автоматически).

2. Вставьте диск компакт-диск RSLinx Classic в ваш дисковод.

Если автозапуск:  То:

включен Запуск программы Setup происходит автоматически, и открывается 
экран программы RSLinx Classic.
 Сразу переходите к шагу 3.

отключен Исполните следующие пошаговые действия:
1. Щелкните по кнопке Start (Пуск), и затем щелкните Run 

(Выполнить). Появляется диалоговое окно Run. .
2. В поле Open (Открыть) напечатайте адрес x:\setup <file://x:/setup>, где x 

- обозначение диска, содержащего CD-ROM RSLinx Classic, и щелкните 
кнопку OK. На мониторе появится экран программы RSLinx Classic.
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3. Следуйте инструкциям, которые появляются на экране.

■ В диалоговом окне программы инсталляции RSLinx Classic нажмите на кнопку 
инсталляции RSLinx Classic, чтобы убедиться, что ваша система соответствует 
минимальным требованиям, а также узнать о новых особенностях, включенных в 
данную версию RSLinx Classic. После прочтения примечаний, щелкните на кнопке 
Install RSLinx Classic.

■ В диалоговом окне Welcome (Знакомство с программным продуктом) прочтите 
вводную информацию о программе RSLinx Classic, и затем щелкните по кнопке Next.

■ В диалоговом окне Software License Agreement прочитайте полностью Лицензионное 
соглашение об использовании программного обеспечения. Нажмите на флажок I 
accept the terms in the license agreement (Я принимаю условия лицензионного 
соглашения), и нажмите кнопку Next (Далее) чтобы принять условия и продолжить 
инсталляцию, или нажмите флажок I do not accept the terms in the license agreement 
(Я не принимаю условия лицензионного соглашения), и нажмите кнопку Next (Далее) 
чтобы отклонить условия и выйти из программы инсталляции.

■ В диалоговом окне Customer Registration Information (Регистрационная 
информация потребителя) напечатайте ваше имя в поле «User Name», название 
вашей организации в поле «Company Name», и серийный номер вашей 
лицензионной копии программы RSLinx Classic, и затем щелкните Next (Далее).
Примечание: Вы можете найти серийный номер для регистрации программы на 
этикетке в коробке вашего компакт диска с программой инсталляции RSLinx 
Classic.

■ В диалоговом окне Standard Setup (Стандартная установка) выберите опции RSLinx 
Classic, которые вы желаете установить. У пользователя есть возможность выбора 
другой папки для установки программы, кроме папки заданной программой по 
умолчанию, а также выбора определенных файлов EDS. Нажмите Next (Далее).

■ В диалоговом окне Ready to Install the Program (Программа готова к установке) 
щелкните на кнопку Install, чтобы запустить процесс инсталляции RSLinx Classic.

■ В диалоговом окне InstallShield Wizard Complete (Завершение работы мастера 
установки) нажмите на флажок Specify, если вы желаете установить активацию, и 
щелкните кнопку Finish (Закончить). (Для получения более подробной информации 
относительно активации, обратитесь к Приложению A в этом руководстве. При этом 
программа RSLinx Classic автоматически перейдет в режим Lite («Легкой» версии), если 
активация не была установлена надлежащим образом. Перед использованием программы 
RSLinx Classic нужно перезапустить компьютер. Инсталляция RSLinx Classic закончена.

4. Как только установка программного обеспечения будет закончена, удалите компакт 
диск с программой установки RSLinx Classic из устройства CD-ROM, и отключите 
Главный диск от дисковода. Храните их в безопасном месте.

Обновление установленной программы

Выполните следующие действия, чтобы обновить (модифицировать) 
установленную программу RSLinx Classic:

1. Вставьте диск с программой установки CD-ROM RSLinx Classic в ваш CD-ROM 
дисковод, и нажмите кнопку Next в диалоговом окне Welcome.

2. В диалоговом окне Program Maintenance (Поддержка программы), нажмите на кнопку 
Remove (Удалить), чтобы удалить программу RSLinx Classic с вашего компьютера.
17
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3. Нажмите кнопку Yes, и затем кнопку Backup (Резервное копирование), чтобы 
создать резервную копию ваших драйверов и разделов. Нажмите кнопку Close 
(Закрыть), чтобы закрыть диалоговое окно Backup/Restore.

4. Щелкните Yes, чтобы удалить файлы EDS из вашего компьютера.

5. В диалоговом окне Remove the Program (Удаление программы), щелкните по 
кнопке Remove (Удаление), чтобы подтвердить процедуру деинсталляции.

6. После того, как процедура деинсталляции будет закончена, щелкните по кнопке 
Finish (Закончить).

7. Для получения более подробной информации, обратитесь к разделу «Установка 
программного обеспечения RSLinx Classic», чтобы правильно установить 
модифицированную версию RSLinx Classic. Чтобы восстановить драйверы и разделы из 
резервной копии, которая была создана в шаге 3, щелкните кнопку Start, затем выберите 
пункт меню Programs > Rockwell Software > RSLinx Classic Backup Restore Utility.

Примечание: Если предварительно была установлена активация, то нет необходимости 
перемещать файл активации. Если активация не была предварительно установлена, 
вставьте Главный диск в дисковод 3,5-дюймовый дисковод. Следуйте инструкциям, 
которые появляются на экране. Для получения более подробной информации 
относительно активации, обратитесь к Приложению A в этом руководстве.

Запуск ПО RSLinx Classic

Чтобы запустить программное обеспечение RSLinx Classic, щелкните кнопку Start, 
затем выберите пункт меню Programs > Rockwell Software > RSLinx Classic.
Примечание: Мы предполагаем, что вы использовали заданные по умолчанию имена папок и 
группы программ. Если вы не использовали заданные по умолчанию имена папок и группы 
программ, то нужно заменить имена, предложенные по умолчанию, фактическими именами, 
которые вы определили для рабочих папок и группы программ при установке программы.

Устранение неисправностей при инсталляции

Если программа RSLinx Classic не запускается или не выполняется должным 
образом, проверьте следующее:

■ имеет ли ваш компьютер достаточно памяти? Запуск RSLinx Classic требует 
минимума 32 Мбайт оперативной памяти.

■ имеет ли ваш компьютер достаточно места на жестком диске? Для нормального 
запуска RSLinx Classic требуется минимум 350 Мбайт свободного места на диске.

■ Установлена ли на вашем компьютере правильная версия RSLinx Classic? Если при 
запуске информации о программе в меню Help или при запуске программы на экране 
загрузки RSLinx Classic версия программы отображается как RSLinx Classic Lite, 
RSLinx Classic Single Node, или RSLinx Classic OEM, это значит файлы активации, 
нужные для работы полной версии, не были установлены. Чтобы просмотреть 
информацию о файлах активации программы RSLinx Classic, выберите пункт Help > 
Copy Protection (Защита от копирования).

■ Если Вы повторно установили более ранний Сервисный пакет или удалили компонент 
(например DCOM), которые требуются для запуска программы RSLinx Classic, то 
программа не будет работать, либо будет работать в ограниченном режиме.
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 RSWho
Эта глава руководства по эксплуатации описывает особенности интерфейса 
системы просмотра сети RSWho. RSWho позволяет вам рассматривать все активные 
сетевые подключения с одного экрана.

Использование RSWho

Интерфейс RSWho является главным окном RSLinx Classic, которое отображает сеть и 
устройства в стиле, подобном проводнику Windows. Щелчком правой кнопки мыши можно 
вывести на экран различные настройки объединенной конфигурации и инструментальных 
средств мониторинга в RSWho. Некоторыми из доступных инструментальных средств 
являются  ControlLogix Gateway Configuration Tool для Controlnet, модули интерфейсов 
DeviceNet, Ethernet, 1756-DHRIO, и 1756-DH485, Ladder Viewer для PLC-5, SLC, или 
процессоров семейства MicroLogix, Монитор Данных для отслеживания текущих данных из 
любого ControlLogix, PLC-5, SLC, или контроллеров семейства MicroLogix.

Левая часть окна RSWho является деревом просмотра, в котором отображается 
информация о сетях и устройствах. Правая часть окна является средством управление 
списками, которое показывает все элементы массива данных в совокупности. Массив 
данных - это совокупность данных являющихся частью сети, или устройство, которое 
является мостом. Щелкните правой кнопкой мыши в списке средств управления, и 
выберите опцию представления Большие значки или Таблица.
Примечание: Устройство, которое появляется с красным значком X, указывает, что 
RSWho опознал это устройство раньше, но теперь не может увидеть это устройство 
и прочитать с него данные. Красный значок X указывает на состояние ошибки связи, 
например отключение опознанного системой устройства. Эти устройства могут 
быть удалены из системы, и перестанут отображаться на экране программы RSWho, 
если щелкнуть правой кнопкой мыши на значке устройства и выбирать команду Remove 
(Удалить).
19
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Просмотр с помощью RSWho

Значок RSWho показывает наличие сети. Если значок  анимирован, это значит что 
сеть находится в состоянии просмотра. Щелкните по значку сети или устройства, 
чтобы начать просмотр.
Когда значки сети или устройств свернуты (это обозначается значком + ), щелкните 
на значке + или дважды щелкните на значке сети или значке устройств рядом со 
значком +, чтобы расширить область просмотра и начать просматривать нужную 
папку. Когда значки сети или устройств развернуты (это обозначается значком – ), 
щелкните на значке – или дважды щелкните на значке сети или значке устройств 
рядом со значком –, чтобы свернуть эту часть дерева папок в значок.
Если флажок Autobrowse (Автоматический просмотр) включен, то программа 
RSWho будет непрерывно просматривать выбранные устройства или сеть 
(независимо от того, какой вариант просмотра был выбран). Если Autobrowse 
выключен, то кнопка Refresh (Обновить) будет активна. Щелкните по кнопке 
Refresh, чтобы запустить в программе RSWho цикл просмотра выбранного 
устройства или сети. Так как после нажатия кнопки Refresh выполняется только 
один цикл обзора, то чтобы обнаружить и просмотреть все необходимые элементы 
сети, может быть необходимо многократное нажатие кнопки Refresh.
Щелкните правой кнопкой мыши на поддерживаемом устройстве, чтобы выбрать 
модуль Station Diagnostics (Диагностика станции), Configure DDE Topic 
(Конфигурировать динамический обмен данными между разделами), или другие 
поддерживаемые сервисы для этого устройства.
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 OPC и обеспечение связи через DDE
Эта глава описывает следующие функциональные возможности:

■ OLE для управления процессами (OPC)
■ Динамический обмен данными (DDE)

OLE для управления процессами (OPC)

OPC, или OLE для управления процессами (Process Control) является стандартом 
связи, основанным на технологии OLE, поставляемой корпорацией Microsoft. 
Технология OLE разрабатывается и обслуживается Ассоциацией разработчиков 
OPC, которая является объединением производственных компаний, членом 
которого является компания Rockwell Automation. Устав этой ассоциации 
обеспечивает межкорпоративный стандартный механизм обмена между 
устройствами прикладного приложения и приложениями клиента. RSLinx Classic – 
это сервер совместимый OPC, предоставляющий интерфейсы, необходимые для 
того, чтобы приложение-клиент OPC получило доступ к данным, согласующимся с 
другими OPC-совместимыми серверами. Дополнительным достоинством RSLinx 
Classic является возможность предоставления нескольких форматов DDE помимо 
OPC.
Формат OLE для управления процессами (OPC) разработан с целью разрешить 
приложениям-клиентам последовательный доступ к данным прикладного 
приложения. OPC обеспечивает много полезных возможностей:
■ Производители аппаратных средств должны поставлять потребителям лишь один 

набор программных компонентов, которые будут использоваться в их приложениях.
■ Разработчики программ не должны перезаписывать драйверы из-за изменений 

функциональных возможностей или дополнений, или в связи с выпуском новой 
версии аппаратных средств.

■ У потребителей появляется возможность выбора способа разработки 
интегрированных корпоративных систем мирового класса.

С OPC, системная интеграция в гетерогенной вычислительной среде является очень 
простым процессом. В среде OLE/COM возможно трансляционное отношение.
RS Linx Classic является OPC-совместимым сервером. Для получения 
дополнительной информации об OPC, посетите сайт Ассоциации OPC (OPC 
Foundation) по адресу www.opcfoundation.org. Для получения дополнительной 
информации о использовании OPC с  программными продуктами Rockwell, 
посетите наш сайт в http://support.rockwellautomation.com.
21



ПОЛУЧЕНИЕ РЕЗУЛЬТАТОВ ПРИ ПОМОЩИ RSLINX CLASSIC

●
●
●
●
●

22
Динамический обмен данными (DDE)

Динамический обмен данными (DDE) - стандартный межпрограммный протокол 
связи, который встраивается в операционные системы Microsoft Windows, и 
поддерживается многими приложениями, которые выполняются в среде Windows. 
Интерфейс DDE берет данные из одного приложения, и передает эти данные 
другому приложению. Это позволяет программам, работающим в среде Windows, 
которые поддерживают динамический обмен данными, обмениваться данными 
между собой.

■ Сервер динамического обмена данными (DDE server)– это программа, которая имеет 
доступ к данным, и может обеспечить доступ к данным других программ Windows.

■ DDE клиент - программа, которая может получать данные с сервера.

Определяя приложение, раздел, и элемент меню, приложение клиента может 
обмениваться данными с приложениями работающими на сервере.
Динамический обмен данными напоминает беседу между двумя людьми. В этом 
случае люди представляют собой различные приложения, выполняющиеся под 
Windows, а то, о чем они говорят - разделяемые этими приложениями данные. 
RSLinx Classic не распознает тип данных, которые в него поступают. В программу 
поступают только сведения про связь по протоколу DDE, который обеспечивает 
обмен данными.
Например, если вы сделали ссылку DDE с программой RSLinx Classic через 
электронную таблицу Excel, то программа Excel не распознает, посылаете ли вы в 
электронную таблицу встречное значение или аналогичное. Все что видит 
пользователь в Excel – это данные.
Например, если RSLinx Classic – имя приложения, то PLC5TOPIC1 – это пример 
названия раздела, и C5:0. ACC – это пример элемента меню. В этом случае, 
встречный сумматор в Allen- Bradley будет иметь обозначение PLC-5.
Примечание: Не все приложения, которые выполняются в среде Microsoft Windows, 
поддерживают DDE. Проверьте в документации данного приложения или обратитесь к 
Интернет-сайту разработчика перед покупкой приложения для совместного 
использования с RSLinx Classic.

Для получения дополнительной информации о DDE, обратитесь к разделу про DDE 
в справочном файле RSLinx Classic.
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Обеспечение связи клиента через DDE/OPC 

RSLinx Classic обеспечивает связь приложений-клиентов,  использующих ОРС или 
разные форматы данных DDE. Интерфейсы OPC и Advance DDE обеспечивают 
оптимизированные операции чтения посредством объединения многих запросов 
от многих клиентов в единую транзакцию. При конфигурировании DDE Topic 
(Раздела DDE) вы можете указать, хотите вы или нет, чтобы операции записи 
элемента данных DDE были оптимизированы.
Оптимизированный элемент данных может работать только с PLC-5 и SLC 
процессорами.
Достоинством оптимизированных операций записи элемента данных DDE является 
объединение нескольких обновлений в одну операцию записи, что уменьшает 
общее число требуемых пакетов.  Во время операций , таких как загрузка 
программных средств, пользователь может выгодно использовать эту 
функциональную возможность.
Другие поддерживаемые форматы DDE включают FastDDE (для клиентов 
Wonderware), XL_Table и CF_Text для поддержки продуктов Microsoft Office, и 
другие базовые приложения-клиенты DDE.
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5
 Поиск необходимой информации
Используйте информацию из этой главы, чтобы рассмотреть источники 
дополнительной информации о программном обеспечении RSLinx Classic. Эта глава 
поможет вам находить то, что вам необходимо для эффективной работы, включая:
■ Использование встроенной подсказки
■ Доступ к сетевым справочникам
■ Использование модуля Answer Station для RSLinx Classic
■ Участие в учебных курсах и тренингах компании Rockwell Software
■ Техническая поддержка

 Использование интерактивной справочной системы

Интерактивная справочная система RSLinx Classic предоставляет основную 
обзорную информацию, исчерпывающие поэтапные процедуры и контекстно-
зависимые определения элементов управления для работы со всеми 
возможностями RSLinx Classic. Для просмотра интерактивной справочной системы 
во время работы программного обеспечения RSLinx Classic:
■ выберите RSLinx Classic Help из меню Help в главном окне RSLinx Classic,
■ щелкните в пункте меню Help по любому диалоговому окну RSLinx Classic или 

вкладке свойств,
■ установите курсор над панелью управления, по которой хотите получить справку, и 

щелкните правой кнопкой мыши, или
■ нажмите F1.
25
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Получение информации об элементе управления или поле

Чтобы вывести на экран определение элемента управления или поля, переместите 
курсор в выбранную область, щелкните правой кнопкой мыши для вывода на 
экран опции What's This? (Что это?), а затем щелкните левой кнопкой для вывода на 
экран определения. В этом примере, были выбраны настройки Property (Свойства).
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Поиск пошаговых процедур

Для просмотра списка задач, имеющих отношение к текущему разделу, 
переместитесь в область What do you want to do? (Что вы хотите сделать?) в нижней 
части окна справочной системы и выберите одну из перечисленных задач. На 
экране появится вспомогательное окно с поэтапной процедурой по выполнению 
данной задачи.
Рассмотрим это на примере раздела справки «What is a driver?» (Что такое 
драйвер?). Если вы выберите пункт «Add a driver » (Добавить драйвер ) в разделе 
«What do you want to do?» (Что вы хотите сделать?), то на экран будет выведена 
справка, которая описывает процедуру, как добавить драйверы RSLinx Classic.
27
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Поиск определений

В справочной системе RSLinx Classic синий текст, выделенный подчеркиванием 
линией, указывает на всплывающее определение или на ссылку к определенному 
разделу. Например, в разделе справки Dynamic Data Exchange, всплывающие 
подсказки доступны для каждого приложения, раздела, и элемента меню, и к 
каждому определению прикреплена соответствующая ссылка DDE, связанная с 
соответствующим разделом.
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Использование модуля Answer Station для RSLinx Classic.

Из меню справки по программе RSLinx Classic, выберите пункт RSLinx Classic 
Assistance on the Web (Помощь по программе в Сети), чтобы получить последнюю 
информацию о программах Rockwell Software, которые вы используете. 
Используйте этот сайт, чтобы узнать о сеансах обучения, предлагаемых для всех 
пользователей RSLinx Classic, а также, чтобы получить доступ к самым последним 
обновлениям и новым версиям, подпишитесь на рассылку по электронной почте в 
разделе MySupport, и прочитайте отзывы других клиентов о программе RSLinx 
Classic.

Доступ к сетевым справочникам

Через адреса сетевых справочников, включенные в программу RSLinx Classic, вы 
можете получить непосредственный доступ к документации по программе RSLinx 
Classic и ее модулям. Это руководство  содержит ссылки на все доступные 
справочники в сети Интернет, а также другие справочные материалы, относящиеся 
к данному ПО. Это руководство содержит все ссылки на доступные справочные 
материалы в портативном формате документов (PDF), относящиеся к данному ПО. 
Эти файлы нужно просматривать, используя программное обеспечение Adobe 
Acrobat Reader, которое вы можете загрузить бесплатно от сайта компании Adobe 
(www.adobe.com).

Обучение

Один из лучших способов увеличивать ваш уровень знаний и навыков в работе с 
данным ПО состоит в том, чтобы пройти программу обучения Rockwell Software на 
нашем Интернет-сайте. Наши программы обучения могут помочь вам овладеть 
основами, и покажут вам, как раскрыть полностью ваш потенциал в работе с нашим 
программным обеспечением.
Мы предлагаем широкий диапазон программ обучения, от регулярно намеченных 
занятий по расписанию, которые проводятся с помощью программных средств 
Rockwell Software, до заказных и специализированных занятий, которые могут 
проводиться по нашей методике на вашем предприятии. Длительность каждого 
курса обучения невелика, чтобы использовать время обучения с максимальной 
пользой.
Если вы хотели бы получать больше информации о наших программах обучения, 
посетите сайт Rockwell Software в глобальной сети Интернет, или свяжитесь с 
Координационной группой компании Rockwell Software по обучению. Наш адрес в 
сети Интернет и контактные номера телефонов указаны на обложке этого 
документа.
Примечание Для получения дополнительной информации об обучении работе с Rockwell 
Software, выберите в меню Help> Support and Training from within RSLinx Classic 
(Поддержка и обучение RSLinx Classic). 
29
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Техническая поддержка

Если вы не можете найти нужные ответы на ваши вопросы в руководстве 
«Получение результатов при помощи RSLinx Classic», интерактивной справочной 
системе, или сетевых справочниках, то вы можете непосредственно связаться со 
службой Технической поддержки Rockwell Software по номерам, указанным на 
обложке этого руководства. Штат технической поддержки работает с понедельника 
по пятницу с 8  до 17 часов по восточноевропейскому времени (или с 1 часа дня до 
10 часов вечера по Гринвичу), за исключением праздников. Также, вы можете 
непосредственно связаться с интерактивной службой Технической поддержки 
Rockwell Software или со справочной библиотекой, размещенной на сайте по 
адресам, указанным на обложке этого руководства.

Когда вы звоните в Службу технической поддержки

Когда вы звоните в службу технической поддержки, вы должны быть возле вашего 
компьютера. Вы должны быть готовы предоставить нашим сотрудникам 
следующую информацию:
■ серийные номера продуктов
■ номер версии программы
■ серийные номера программы и номер версии могут быть найдены в меню 

программы. Чтобы получить серийные номера, зайдите в меню Help> About RSLinx 
Classic.

■ информацию об аппаратных средствах, которые вы используете на своем 
компьютере точную формулировку любых ошибок или сообщений, которые 
появились на вашем экране описание возникшей проблемы, и что вы при этом 
делали описание того, как вы пытались решать проблему.



А
 Активация
RSLinx Classic 2.52.00 (CPR 9) поддерживает два вида активации - Factory Talk и 
EVRSI.
К сведению: Как новый пользователь вы должны активировать ваше программное 
обеспечение, используя программу FactoryTalk Activation, потому что RSLinx Classic 
больше не отправляется пользователю с физическим «главным диском» для того, 
чтобы активировать программное обеспечение. Для получения дополнительной 
информации, читайте раздел «Активация RSLinx Classic с FactoryTalk Activation» в 
приложении А к данному руководству. Если вы собираетесь обновить вашу программу 
RSLinx Classic 2.52.00, то вы можете продолжить использовать EVRSI для активации 
вашего программного обеспечения. Для получения дополнительной информации, 
читайте раздел А этого приложения 'Активация RSLinx Classic с EVRSI’. Активация 
EvRSI  будет заменена программой FactoryTalk Activation в следующей версии 
программы, которая скоро выйдет.
Если вы используете активацию EvRSI , свяжитесь с вашим местным представителем 
компании Rockwell  Automation,  отделом продаж или Службой технической поддержки, 
чтобы получить информацию относительно переноса ваших настроек активации в 
программуFactoryTalk Activation. Для связи со Службой технической поддержки Rockwell 
Automation в США звоните по телефону 1 (440) 646-3434. Вне США смотрите 
информацию на Интернет-сайте http://www.rockwellautomation.com/locations/.

Активация RSLinx Classic с FactoryTalk Activation 

Программа FactoryTalk Activation для RSLinx Classic 2.52.00 (CPR 9) и 
поддерживаемые ей модули называется активацией с блокированными узлами. Этот 
тип активации может быть жестко привязан к определенной части аппаратных 
средств, например сетевой карте Ethernet или жесткому диску автономного 
компьютера, или к электронному ключу. В зависимости от вида устройства 
(автономный компьютер или аппаратный защитный ключ), с помощью которого вы 
хотите активировать данное ПО, вы можете купить также:
■ Локальная «узловая лицензия» - этот вид активации, с помощью которой 

программное обеспечение активируется только на одном отдельном компьютере. 
Если файл активации скопирован на другой компьютер, то программное 
обеспечение не будет выполняться на этом или другом компьютере.

■ Мобильная «узловая лицензия» - этот вид активации, которая привязана к одному 
аппаратному защитному ключу. Защитный ключ - является защитой или 
устройством защиты от копирования, которое должно быть связано с компьютером 
во время выполнения программы. Файлы активации могут быть скопированы на 
несколько компьютеров, но программное обеспечение может быть активировано 
только на одном компьютере, с которым связан защитный ключ.
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Как активировать RSLinx Classic

Чтобы активировать вашу копию RSLinx Classic, выполните следующие пошаговые 
действия:

1. Установите клиент FactoryTalk Activation Client, который можно запустить на 
экране Optional Steps (Необязательные шаги) в программе установки.

2. Как только клиент FactoryTalk Activation Client будет установлен, загрузится мастер 
активации FactoryTalk Activation Wizard, который будет вести вас через пошаговую 
процедуру загрузки файлов для активации из Интернета. Вы можете загрузить файл 
активации на ваш автономный компьютер или аппаратный защитный ключ.

Поиск детальной информации о FactoryTalk Activation

Для получения справки FactoryTalk Activation по любому вопросу, вы можете 
нажать в меню на:
■ кнопку Help в любом диалоговом окне программы FactoryTalk Activation Tool, или в 

диалоговом окне FactoryTalk Activation Transfer Tool.
■ ссылку на справку Help на сайте по активации ПО Rockwell Software: 

http://licensing.software.rockwell.com
■ кнопку View How to Activate Rockwell Software Products (Как активировать 

программы) во вкладке Required Steps (Необходимые пошаговые действия) в окне 
программы установки.

Если вы не можете подключиться к  Интернету, позвоните в нашу Службу 
технической поддержки для получения информации о том, как создать файл 
активации посредством электронной почты или факса.
Телефон: 440-646-3434 в Северной Америке. Если вы проживаете вне территории 
Северной Америки, то вам нужно обратиться в ваше местное отделение Службы 
технической поддержки.
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Активация RSLinx Classic с EVRSI

Программы Rockwell Software защищены от копирования. Только на компьютерах с 
доступом к ключу активации может выполняться программное обеспечение Rockwell 
Software. Ключ активации расположен в файле активации, который расположен на 
Главном диске, который поставляется с программой RSLinx Classic. Файл активации 
содержит один ключ активации на одну копию программы. Каждый ключ содержит 
одну или более лицензий в зависимости от того, сколько копий программы вы купили.
Примечание Храните ваш Главный диск в безопасном месте. Если данные по вашей 
активации повреждены, то ваш Главный диск может быть единственным средством, 
которое позволяет восстановить контроль над вашим программным обеспечением в 
критической ситуации.
Во время процесса установки, программа установки дает вам возможность 
переместить файл активации с Главного диска в корневой каталог на жестком  
диске, на котором вы обычно устанавливаете свое программное обеспечение.
Когда вы запускаете программу RSLinx Classic, то программа сначала проверяет 
локальные жесткие диски, затем сетевые жесткие диски, и, наконец локальные дисководы 
для гибких дискет на наличие файлов для активации программы. Если система не в 
состоянии обнаружить файл активации или Главный диск, то ваше программное 
обеспечение начнет работать в демонстрационном режиме RSLinx Classic Lite.
Примечание: В тех системах, которые подключены к обширным сетям, может 
потребоваться много время, чтобы найти файлы, нужные для активации на всех доступных 
дисках. Вы можете использовать переменную среду CHECKDRIVES, чтобы определить и/или 
ограничить поиск на дисках, где ваше программное обеспечение проверяет файлы 
активации, и определить порядок, в котором они будут проверены. Обратитесь к файлу 
встроенной подсказки утилит активации, выбирая Help> Copy Protection.

Как активировать RSLinx Classic

В зависимости от ваших потребностей, вы можете активировать RSLinx Classic с 
любого указанного ниже устройства:
Жесткий диск.  Ключ активации постоянно находится на жестком диске вашего 
компьютера. Используйте этот метод, если вы будете использовать программу RSLinx 
Classic только на одном компьютере. Это - заданный по умолчанию метод, если вы 
активируете программу RSLinx Classic во время инсталляции. Чтобы выполнить 
программу RSLinx Classic на различных компьютерах, поместите ключ активации 
обратно  на Главный диск, и затем вставьте Главный диск в дисковод нового компьютера.

Дисковод. Ключ активации постоянно находится на гибком диске (диск активации). 
Используйте этот метод, если вы будете использовать программу RSLinx Classic на 
нескольких компьютерах. Если вы хотите выполнить программу RSLinx Classic на 
настольном компьютере несколько раз, или на портативном компьютере для 
нескольких разных пользователей.
Сетевой диск. Ключи активации постоянно находятся на сетевом диске. Используйте 
этот метод, если вы купили несколько лицензий на использование программного 
обеспечения, и хотите, чтобы несколько пользователей могли активировать 
программное обеспечение по сети. Обратитесь к встроенной подсказке по командам 
мобильной активации на сетевом диске. Смотрите раздел «Поиск детальной 
информации об активации» в этой главе, чтобы обратиться к интерактивной справке.
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Защита файлов активации

Чтобы избежать повреждения ваших файлов активации, не используйте следующие 
операции с файлами активации на жестком диске:
■ Восстановление из резервной копии
■ Модернизация операционной системы
■ Компрессия или декомпрессия жесткого диска

Утилиты дефрагментации не будут вредить файлам активации.
Перед выполнением любого типа утилиты, которая может изменить структуру или 
организацию жесткого диска, удалите файлы активации с жесткого диска:

1. Используйте утилиту Move Activation (EvMove), чтобы переместить файлы 
активации с жесткого диска на диск активации.

Запустите файл EVMOVE.EXE с вашего жесткого диска (расположенный в 
C:\Program <file://C:/Program> Files\Rockwell Software\RSUtil, если вы приняли 
местоположение основной рабочей папки по умолчанию в начале инсталляции).

2. Выполните операцию с жестким диском.

3. Переместите файлы активации обратно на жесткий диск.

Некоторые пакеты антивирусных программ, например Norton Anti-virus, могут разрушить файлы 
активации. Настройте конфигурацию вашего антивирусного программного обеспечения таким 
образом, чтобы избежать проверки файлов EVRSI.SYS и 386SWAP.PAR.

Не используйте утилиту Move Activation, если в данный момент выполняются программы 
Rockwell Software. Проверьте, чтобы все программы были закрыты перед запуском утилиты 
EvMove.

Для перемещения файлов активации, пользователь должен использовать только утилиту 
перемещения EvMove. Любые попытки копировать, переместить, или направить файл активации 
по электронной почте с помощью любых других средств могут повредить файл активации.
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ЗАПУСК УТИЛИТ АКТИВАЦИИ
Утилиты для перемещения или перенастройки файлов активации называются 
соответственно EvMove и Reset. Reset используется, если файл активации был 
поврежден. Файлы EVMOVE.EXE и RESET.EXE расположены на вашем жестком 
диске (в C:\Program Files\Rockwell Software\RSUtil, если вы приняли 
местоположение основной папки, предложенное по умолчанию во время 
инсталляции). Чтобы выполнить эти программы, выберите меню Start 
(Пуск)>Programs (Программы)> Rockwell Software > Utilities > Move Activation 
или Reset Activation.

Некоторые общие вопросы

Ниже изложены некоторые общие проблемы, с которыми пользователи сталкиваются в 
процессе активации, а также пути их решения.

МОИ ФАЙЛЫ АКТИВАЦИИ БЫЛИ ПОВРЕЖДЕНЫ. ЧТО МНЕ СЛЕДУЕТ ДЕЛАТЬ?
Если вы потеряли активацию, потому что файл активации был поврежден, то вы 
должны сбросить прежнюю активацию. Следуйте инструкциям, изложенным в 
разделе Reset Codes (Сброс кодов) на Интернет-странице Технической поддержки 
Rockwell, или свяжитесь по телефону со Службой технической поддержки. Номер 
телефона и адрес Интернет-страницы, по которым можно связаться со Службой 
технической поддержки Rockwell Software, указаны на обложке этого руководства.
Если вы не можете получить код сброса немедленно, следуйте этим инструкциям, и 
используйте Главный диск, чтобы активировать программное обеспечение как 
временное решение.
Используйте Главный диск, чтобы активировать программное обеспечение:

1. Установите в среде KEYDISK параметр environment variable (переменная среда) на 
TRUE. (Используйте интерактивную справку).

2. Вставьте ваш Главный диск в дисковод. 

3. Запустите ваше программное обеспечение, как вы это обычно делаете. Ваше 
программное обеспечение само найдет файлы активации на Главном диске.

Я СЛУЧАЙНО УДАЛИЛ ПАПКУ С ПРОГРАММАМИ НА МОЕМ ЖЕСТКОМ ДИСКЕ. 
НУЖНО ЛИ МНЕ ЗВОНИТЬ В ТЕХНИЧЕСКУЮ СЛУЖБУ ROCKWELL SOFTWARE 
ДЛЯ ЗАМЕНЫ ФАЙЛОВ АКТИВАЦИИ?
Нет. Удаление файлов программы не удаляет вашу активацию. Файлы активации не 
сохраняются в папке программы; они хранятся в корневой папке жесткого диска. 
Ваши файлы активации не будут потеряны, если вы не форматируете жесткий диск 
и не вмешиваетесь в структуру скрытых файлов в корневой папке жесткого диска, 
или выполняете некоторые другие операции на жестком диске. Обратитесь к 
разделу «Защита файлов активации» в этой главе для получения дополнительной 
информации.
Чтобы снова запустить программное обеспечение, просто повторно установите его в 
ту же папку, но по возможности не перемещайте файлы активации.
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ПОЧЕМУ Я НЕ МОГУ ПЕРЕМЕСТИТЬ АКТИВАЦИЮ НА НОВЫЙ ГИБКИЙ ДИСК НА 
СИСТЕМЕ WINDOWS NT?
Это имеет отношение к изменениям на жестком диске, которые NT не позволяет 
сделать. Если вы имеете доступ к машине с различными версиями операционной 
системы Windows, вы можете создать раздел на диске, который будет работать под 
NT. Форматируйте дискету, или переместите любой файл активации под Windows 
XP, 2000, Me, или 98. Вы можете переместить файлы активации назад на жесткий 
диск, если хотите сохранить эти файлы там, где они были изначально. Тогда 
возьмите этот диск, вставьте на вашу машину с операционной системой Windows 
NT, и переместите файлы активации на него.

Поиск информации по активации

В интерактивной справочной системе (COPYPROT.HLP) представлена более 
обширная информация относительно активации, включающая такие разделы как:
КЛЮЧЕВОЙ ДИСК. Задайте параметры переменной среды таким образом, чтобы 
ваш компьютер искал активацию в дисководах для гибких дискет.
ПРОВЕРКА ДРАЙВЕРОВ. Задайте параметр CHECKDRIVES (Проверка 
драйверов) таким образом, чтобы определить системе место, где искать файлы 
активации.
Активация по сети. Переместите активацию на сетевой сервер, чтобы 
предоставить многим пользователям доступ к файлам активации.
Перемещение файлов активации. Для перемещения файлов активации 
обращайтесь к более подробным инструкциям.
Сброс активации. Для восстановления поврежденного файла активации 
обращайтесь к более подробным инструкциям по использованию утилиты Reset. 
Устранение неисправностей. Просматривайте сообщения об ошибках, так как в 
них содержатся предложения по решению проблем.
Также вы можете обратиться к интерактивной справке:
■ нажав на кнопку Help в одном из диалоговых окон программы EvMove или Reset.
■ в программе RSLinx Classic, выбирая Help > Copy Protection в главном меню, не 

запуская ни программу RSLinx Classic, ни утилиты активации.
■ В меню Start (Пункт) в системе Windows, выберите пункт Programs (Программы)> 

Rockwell Software > Utilities > Activation Help (Справка по активации), если вы 
приняли местоположение основной папки, предложенное по умолчанию во время 
инсталляции.



B
 Обеспечение защиты RSLinx Classic с 
FactoryTalk Security

FactoryTalk Security™ предназначен для того, чтобы улучшить защиту вашей 
системы автоматизации, предоставляя к ней доступ только тем пользователям, 
которым это необходимо. FactoryTalk Security авторизует пользователя, и 
предоставляет запросам пользователя доступ к системе под управлением 
FactoryTalk. Эти сервисы защиты информации полностью интегрированы в 
программу FactoryTalk Directory, а также являются частью платформы FactoryTalk 
Services Platform, которая устанавливается со многими продуктами.
Для получения дополнительной информации о том, как использовать сервисы 
защиты информации, пожалуйста обратитесь к интерактивной справочной системе 
FactoryTalk Security.

Как устанавливать защиту в RSLinx Classic?

В программе RSLinx Classic 2.52.00 (CPR 9), наряду с поддержкой RSSecurity, также 
поддерживается FactoryTalk Security. FactoryTalk Security™ предназначен для того, 
чтобы улучшить защиту вашей системы автоматизации, предоставляя к ней доступ 
только тем пользователям, которым это необходимо. FactoryTalk Security авторизует 
пользователя, и предоставляет запросам пользователя доступ к системе под 
управлением FactoryTalk в соответствии с набором определенных пользовательских 
учетных записей и привилегий доступа , которые содержатся в FactoryTalk 
Directory. Для получения дополнительной информации о FactoryTalk Security, 
читайте раздел «О FactoryTalk Security» в интерактивной справочной системе 
RSLinx Classic. В приведенной ниже таблице рассматриваются пошаговые действия, 
которые вы должны выполнить, чтобы активировать один из двух механизмов 
защиты (FactoryTalk Security и RSSecurity), которые поддерживаются программой 
RSLinx Classic.

Если вы:   Сделайте следующее:

пользователь, который 
хочет:
■ использовать 
FactoryTalk Security, 
и
■ который никогда не 
конфигурировал 
параметры безопасности 
RSSecurity

1. Установите FactoryTalk Services Platform, нажав 
соответствующую кнопку на  экране Optional Steps программы 
установки RSLinx Classic. Во время установки FactoryTalk 
Services Platform нужно установить настройки FactoryTalk 
Directory.

2. Установите RSSecurity Emulator из меню Start (Пуск)> 
Programs (Программы)> Rockwell  Software > FactoryTalk 
Tools (Инструменты Factory Talk) > RSSecurity Emulator 
(Эмулятор RSSecurity).
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Если вы:  Сделайте следующее:
Примечание: Во время установки RSSecurity Emulator, появляется 
экран установки FactoryTalk Directory (смотрите следующий 
рисунок), где будет выдаваться запрос на выбор папки для 
установки FactoryTalk Directory (на сетевой или на локальный 
диск), которую должен использовать RSSecurity Emulator. На этом 
этапе (шаг 5) установки запишите местонахождении папки, 
которую вы выбрали. Эта информация может потребоваться при 
добавлении настроек политики безопасности в FactoryTalk 
Directory.

3. Установите RSLinx Classic с помощью экрана RSLinx Classic 
Required Steps Install.

4. При выполнении мастера инсталляции RSLinx Classic, 
появляется экран выбора настроек защиты Security Configuration 
Selection. На этом экране выберите опцию Enable Security 
(Включить защиту).
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Если вы:   Сделайте следующее:
5. Нажмите кнопку Next, чтобы закончить установку RSLinx 

Classic.
6. Откройте консоль FactoryTalk Administration Console (Консоль 

администрирования FactoryTalk) в меню Start (Пуск) 
>Programs (Программы)> Rockwell Software > FactoryTalk 
Administration Console, чтобы добавить учетные записи 
пользователя, и установить параметры настройки защиты 
RSLinx Classic.

Примечание:

■ Для получения дополнительной информации о том, как 
добавлять учетные записи пользователя, читайте раздел Add a 
user account (Добавить учетную запись пользователя) в справке по 
FactoryTalk Administration Console, расположенной в меню Manage 
FactoryTalk-enabled systems  (Управление системами с 
FactoryTalk)> Log on and configure security (Регистрация и 
конфигурирование безопасности) > Configure 
security(Конфигурирование безопасности) > How To (Как..) > 
Work with user accounts(Работать  с учетными записями 
пользователей) > Add a user account(Добавить учетную запись 
пользователя). Для получения дополнительной информации о том, 
как обезопасить настройки программы RSLinx Classic, читайте 
раздел Secure Product Features (Защита функциональных 
возможностей программы) в справке по FactoryTalk 
Security,который  расположен в меню Configure Security > How to > 
Set up product policies(Установить параметры безопасности 
продукта) > Secure product features (Возможности обеспечения 
безопасности продукта).

■ Для получения дополнительной информации о защите RSLinx 
Classic, читайте раздел интерактивной справки What can I secure 
in RSLinx Classic (Что можно защитить в RSLinx Classic), 
который располагается в меню How to > Secure RSLinx Classic 
with FactoryTalk (Обеспечение безопасности RSLinx Classic с 
FactoryTalk) > What can I secure in RSLinx Classic.
7. Чтобы запустить программы настройки защиты RSLinx Classic, 

щелкните кнопку Start (Пуск), затем выберите пункт меню 
Programs (программы), и там нажмите на Rockwell Software > 
RSLinx > RSLinx Classic, затем нажмите на Security > Set 
Security User (Установка защищенного пользователя) в главном 
меню. В диалоговом окне New User (Новый пользователь), 
введите имя пользователя и пароль пользователя, которого вы 
создавали в консоли FactoryTalk Administration Console при 
выполнении шага 6, и щелкните кнопку OK. 

Примечание: Поскольку доступ к функциональным возможностям 
RSLinx Classic осуществляется на основе прав, которые вы 
устанавливаете для пользователей в консоли FactoryTalk 
Administration Console, некоторые из 13функциональных 
возможностей обеспечения безопасности RSLinx Classiс, могут быть 
недоступны (например, если пользователь, которого вы ввели при 
выполнении шага 7, не имеет соответствующего права).
Эти действия завершают установку защиты для программы RSLinx 
Classic.
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Если вы:   Сделайте следующее:

пользователь, который 
хочет:
■ использовать 
FactoryTalk Security, а так 
же как 
■ импортировать  
существующие 
настройки RSSecurity в 
FactoryTalk Directory

1. Установите FactoryTalk Services Platform, нажав 
соответствующую кнопку на экране установки RSLinx Classic 
Optional Steps Install. Вместе с настройками FactoryTalk Services 
Platform нужно также установить настройки FactoryTalk 
Directory.

2. Запустите Security Config Explorer, выбирая Start 
(Пуск)>Programs (Программы) > Rockwell Software > 
Security Server Network Edition (Сетевая версия сервера 
безопасности)  > Security Config Explorer (Проводник по 
настройкам конфигурации).

3. Определите местонахождение RSSecurity Configuration (*.bak) 
файл, и выберите File(Файл)> Export  (Экспорт) в резервную 
копию в *.bak файл.

4. Закройте Security Config Explorer.
5. Деинсталлируйте RSSecurity Server/Client, в независимости от 

того, какая версия установлена на этой машине, нажав на кнопку 
Start (Пуск)> Settings (Настройка) > Control Panel (Панель 
управления)> Add/Remove Programs (Установка и удаление 
программ).

6. Установите RSSecurity Emulator из меню Start (Пуск)> Programs 
(Программы)> Rockwell Software > FactoryTalk Tools 
(Инструменты Factory Talk) > RSSecurity Emulator (Эмулятор 
RSSecurity).

Примечание: Во время установки RSSecurity Emulator, появляется 
экран установки FactoryTalk Directory (смотрите следующий 
рисунок), где появится запрос на выбор папки для установки 
FactoryTalk Directory (на сетевой или на локальный диск), которую 
должен использовать RSSecurity Emulator. На этом этапе 
установки запишите местонахождении папки, которую вы выбрали 
для установки программы. Это информация может потребоваться 
при импорте настроек из резервного файла в FactoryTalk Directory 
при выполнении шага 10.
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Если вы:   Сделайте следующее:

7. Установите RSLinx Classic, поэтапно выполнив действия RSLinx 
Classic Required Steps Install на экране установки.

8. При выполнении мастера инсталляции RSLinx Classic 
появляется экран выбора настроек Security Configuration 
Selection (Выбор настроек защиты). На этом экране выберите 
опцию Enable Security (Включить защиту), но не выбирайте 
опцию Add security policies to the FactoryTalk Directory 
(Добавить политику безопасности в каталог FactoryTalk 
Directory).
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Если вы:   Сделайте следующее:
9. Нажмите Next, чтобы продолжить инсталляцию.
10. Импортируйте базу данных сервера RSSecurity, нажав на кнопку 

Start (Пуск)> Programs (Программы)> Rockwell Software > 
FactoryTalk Tools (Инструменты Factory Talk) > Import 
RSSecurity Configuration (Импорт настроек RSSecurity).

Примечание: При выполнении импорта настроек из RSSecurity 
Configuration, на экран будет выведено диалоговое окно FactoryTalk 
Security Import (Импорт параметров безопасности в FactoryTalk) 
(смотрите следующий рисунок). В списке Destination (Назначение)  в 
этом диалоговом окне, убедитесь, что импортировали .bak файл в 
тот каталог, в который вы устанавливали программу Emulator (см. 
шаг 7). Выбрав заданную по умолчанию опцию в поле адреса, вы 
зададите адрес для хранения вашего файла в каталоге Network (Сеть)..

11.Откройте RSLinx Classic, и выберите в меню  Security 
(Безопасность) > Set Security User (Установка защищенного 
пользователя) из главного меню. В диалоговом окне New User 
(Новый пользователь), введите имя пользователя (имя 
домена\имя пользователя) и пароль пользователя в RSSecurity .

Примечание: Если вы не помните имена пользователей, которые 
существовали в вашей старой установленной программе 
RSSecurity, поэтапно выполните следующие действия:
A. Запустите консоль  FactoryTalk Administration Console, выбрав 
из меню Start (Пуск)> Programs (Программы)> Rockwell Software > 
FactoryTalk Administration Console.
B. В области просмотра окна Проводника, разверните дерево 
каталога  FactoryTalk Local или Network Directory(Локальный или 
сетевой каталог FactoryTalk), и затем разверните  папку Systems 
(Cистемы), пока не будет видна папка  Users (Пользователи).
С. Вы увидите пользователей RSSecurity в папке Users 
(Пользователи). Это будут пользователи, учетные записи 
которых ассоциированы с доменом (например, na\Bob) .
Примечание: Поскольку доступ к функциональным возможностям 
RSLinx Classic управляется через права, которые вы устанавливаете 
для пользователей в консоли  FactoryTalk Administration Console, 
некоторые настройки из 13 функциональных возможностей 
обеспечения безопасности в RSLinx Classiс, могут быть недоступны 
(например, если пользователь, которого вы ввели на стадии  шага 11, 
не имеет соответствующего права).
Эти действия завершают установку функций безопасности для 
программы RSLinx Classic.
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Что можно защитить в RSLinx Classic?

Следующая таблица объясняет те возможности, к которым вы можете ограничить 
доступ в RSLinx Classic. Например, вы можете предоставить возможность 
завершения сервисов RSLinx Classic ограниченной группе пользователей, а также 
предотвратить отказ компонентов вашей системы автоматизации  во время 
выполнения программ.
Примечание: Если во время выбора процедуры установки защиты RSLinx Classic вы 
выбрали Network Directory (Сетевой каталог), то вы должны использовать FactoryTalk 
Security, чтобы обеспечить безопасность следующих функциональных возможностей. 
Чтобы получить более подробную информацию, свяжитесь с вашим местным 
представителем или дистрибьютором компании Rockwell Automation.

Защищенная функциональная 
возможность

Описание

Очищение журнала регистрации 
событий DDE/OPC   

Отображает информацию о любых сообщениях об ошибках 
протокола DDE/OPC, зарегистрированных при выполнении 
RSLinx Classic с программами совместимыми с DDE/OPC.

Конфигурирование опций 
комплексной обработки 
информации (CIP) внутри сети

Управляет тем, как PCCC посылает запросы, в которых 
используется протокол CIP.

Конфигурирование 
пользовательских приложений 

Привязывает сконфигурированные и используемые драйверы 
RSLinx Classic к действующему INTERCHANGE C (API), а 
также отображает идентификатор ссылки виртуальной сети, 
который поддерживается программой RSLinx Classic для 
использования в приложении - клиенте в моделе передачи 
сообщений, основанной на предоставлении ссылок.

Конфигурирование шлюза  
ControlLogix 

Обеспечивает вас информацией о модулях в вашем шлюзе 
ControlLogix Gateway.

Конфигурирование разделов 
DDE/OPC

Настраивает раздел интерфейса DDE/OPC

Конфигурирование драйверов и 
ярлыков

Выбор конфигурации (добавление, редактирование, или 
удаление) драйверов и ярлыков, которые позволяют RSLinx 
Classic связываться с вашим PLC, а также обеспечивать 
быстрый доступ к определенным сетям.

Конфигурирование шлюза Позволяет вам включать шлюзы в программе RSLinx Classic 
Gateway.

Конфигурирование свойств сети Позволяет вам настроить свойства сети.

Редактирование проекта DDE/
OPC 

Позволяет вам редактировать ваш проект в интерфейсе 
DDE/OPC.

Опции редактирования Отображает диалоговое окно опций, которое содержит 
вкладки динамического обмена данными и основные 
вкладки.

Диагностика  станций сброса Сбрасывает значения счетчиков на диагностическом экране 
станций.

Выключение счетчиков  Настройка режимов завершения RSLinx Classic.

Просмотр журнала событий NT Записывает важные системные события, возникающие при 
работе с драйверами в RSLinx Classic, включая успешные 
запуски и остановки.
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Рассмотрение проблем, возникающих при использовании 
FactoryTalk Security для RSLinx Classic

При использовании FactoryTalk Security для RSLinx Classic, следует иметь в виду 
следующее:

СЕТЕВОЙ И ЛОКАЛЬНЫЙ КАТАЛОГ

FactoryTalk Services Platform может установить два отдельных полностью 
независимых каталога FactoryTalk : сетевой каталог и локальный каталог. Учетные 
записи пользователей, пароли, и права использования защищаемых 
функциональных возможностей программ являются полностью раздельными, и не 
могут совместно использоваться сетевым и локальным каталогом. Настройка 
конфигурации любого из этих элементов меню на одном каталоге не отражается на 
конфигурации другого каталога. Точно так же изменение пароля к учетной записи 
пользователя в одном каталоге не изменяет пароль в другом каталоге, даже если 
учетная запись имеет то же самое имя в обоих каталогах.
Для нормальной работы в одном из этих двух каталогов  при настройке 
конфигурации RSLinx Classic, пожалуйста учтите следующее:
■ Политика безопасности RSLinx Classic и RSSecurity Emulator должны быть 

установлены в одном и том же каталоге (локальном или сетевом).
■ Если вы настроили конфигурацию RSLinx Classic, чтобы работать в сетевом 

каталоге, вы должны использовать программу FactoryTalk Security, чтобы управлять 
централизованной защитой сети.

■ Если вы настроили конфигурацию RSLinx Classic, чтобы работать в локальном 
каталоге, вы должны использовать программу FactoryTalk Security, чтобы управлять 
защитой отдельного компьютера.
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СБРОС СЕТЕВОГО ДЕРЕВА

При повторной установке RSLinx Classic, все параметры безопасности, которые 
были предварительно установлены в конфигурации для сетей и устройств, будут 
потеряны. Нужно заново определить параметры безопасности в сетях и дереве 
устройств, или в RSWho. Для получения дополнительной информации, читайте 
раздел «Network and Devices are not displayed correctly» (Если сеть и устройства не 
отображаются правильно) в справке к FactoryTalk Security, которая находится в 
меню Configure security (конфигурирование безопасности) > Troubleshooting 
security (Устранение неполадок в области обеспечения безопасности) > Network и 
Devices are not displayed correctly.

РАЗНОЕ
При использовании FactoryTalk Security для RSLinx Classic, следует иметь в виду 
следующее:
■ Если вы не отмечали флажок enable security (включить защиту) в диалоговом окне, 

которое появляется на экране в процессе установки RSLinx Classic, но хотите 
включить защиту сейчас, то вам нужно будет сначала деинсталлировать, и затем 
повторно установить RSLinx Classic.

■ Каждый раз, когда вы работаете в RSLinx Classic, проверяйте, чтобы имя 
пользователя, отображенное в текстовом поле Current Security User (Текущий 
защищенный пользователь) в диалоговом окне Set Security  (Security > Set Security 
User (Установка защищенного пользователя) отображалось правильно. Если 
отображаемое имя пользователя неправильное, введите новое имя пользователя и 
пароль, затем щелкните OK.
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Глоссарий
Диск активации - любой диск (дискета или жесткий диск), содержащий файл 
активации. Диск активации может использоваться для активации программного 
обеспечения. Диск активации отличается от ключевого диска (Главный диск) тем, 
что на диске активации должна быть доступна по крайней мере одна лицензия на 
программное обеспечение, чтобы активировать программное обеспечение.
Файл активации - скрытый, системный файл только для чтения, который 
«активирует» программный продукт Rockwell. Программное обеспечение может 
быть запущено только в том случае, если ваша система может найти правильный 
файл активации.
Ключ активации - файлы активации содержат базу данных ключей активации. 
Каждый ключ является специфическим, и подходит только к определенному 
продукту (программе), и должен быть доступен на локальном или удаленном диске, 
чтобы программа могла запуститься и работать.
Драйвер - программный интерфейс на аппаратное устройство, которое будет 
использоваться, чтобы установить связь между RSLinx Classic и процессором 
пользователя.
Динамический обмен данными (DDE) – формат взаимодействия между 
процессами. Если одновременно запущено две или несколько программ, которые 
поддерживают формат DDE, то эти программы могут одновременно обмениваться 
информацией и командами. 
Ключевой диск - гибкий диск, который может использоваться для активации 
программного обеспечения, даже если этот диск не содержит файлы лицензии. 
Главный диск – это единственный ключевой диск. Этот диск отличается от диска 
активации тем, что диск активации должен содержать по крайней мере одну 
лицензию.
Лицензия - Разрешение использовать указанное количество копий программного 
обеспечения. Ключ активации программы содержит лицензию для каждой копии 
программного обеспечения, которое вы купили. Например, если вы купили семь 
копий RSLinx Classic, тогда набор RSLinx Classic будет включать Главный диск, 
который содержит семь файлов «лицензий» RSLinx Classic. Вы можете переместить 
файл активации для RSLinx Classic на семь разных компьютеров.
Ссылки - путь для данных, установленный для одного или нескольких каналов 
между двумя или несколькими рабочими станциями. Ссылки DDE могут быть 
«горячими», «теплыми», или «холодными».
Главный диск - Это диск, который поставляется пользователю вместе с 
программным обеспечением. Этот диск содержит базу данных ключей в «файле 
активации», который дает возможность выполнять команды программного 
обеспечения. Храните ваш Главный диск в безопасном месте. Если ваш файл 
активации повреждается, то единственный способ, которым вы можете запустить 
ваше программное обеспечение (пока активация не сброшена) – это запустить 
программу с Главного диска.
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OPC – Формат обмена данными, обеспечивающий стандартное средство для 
коммуникации и обмена данными между клиентами и серверами с помощью 
технологию OLE.
Пакет - модуль передачи для обмена данными на сетевом уровне.
Запись элемента данных (Poke)  – версия для записи в формате DDE.
Чтение – функция импорта данных из различных источников (память, устройства 
вывода, другая рабочая станция).
Раздел - определенный путь для отправки данных на обработку.
Запись – функция экспорта данных в различные источники (память, устройства 
вывода, другая рабочая станция).
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